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Preface 
The Oracle documentation set includes Adobe® Acrobat™ PDF files. The Oracle Technology 
Network (OTN) Web site (http://www.oracle.com/technology/documentation/agile.html) contains the 
latest versions of the Oracle Agile EDM PDF files. You can view or download these manuals from 
the Web site, or you can ask your Agile administrator if there is an Oracle Documentation folder 
available on your network from which you can access the documentation (PDF) files. 

Note  To read the PDF files, you must use the free Adobe Acrobat Reader™ version 7.0 or 
later. This program can be downloaded from the Adobe Web site 
(http://www.adobe.com). 

 

Note  Before calling Agile Support about a problem with an Oracle Agile EDM manual, please 
have the full part number, which is located on the title page. 

TTY Access to Oracle Support Services 

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the 
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398. 
Outside the United States, call +1.407.458.2479. 

Readme 

Any last-minute information about Oracle Agile EDM can be found in the Release Notes file on the 
Oracle Technology Network (OTN) Web site 
(http://www.oracle.com/technology/documentation/agile_eseries.html) 

 

Agile Training Aids 

Go to the Oracle University Web page 
(http://www.oracle.com/education/chooser/selectcountry_new.html) for more information on Agile 
Training offerings. 

Accessibility of Code Examples in Documentation  

Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise empty line; 
however, some screen readers may not always read a line of text that consists solely of a bracket or 
brace.  

Accessibility of Links to External Web Sites in Documentation  
This documentation may contain links to Web sites of other companies or organizations that Oracle 
does not own or control. Oracle neither evaluates nor makes any representations regarding the 
accessibility of these Web sites.

 vii 
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Chapter 1  

Introduction 
The Administration Guide describes how to administrate the installed Agile e6.1.1 components. 

About Agile e6.1.1 Administration 
An Agile e6.1.1 application/environment defines a particular hardware and software configuration 
that allows Agile e6.1.1 to work with an Oracle database, Oracle Application Server.  

Note  We will use the word “application” instead of “environment” in this documentation. 

To administrate Agile e6.1.1, you can create and manage Agile e6.1.1 applications. For each 
created Agile e6.1.1 application, information is stored on the Agile e6.1.1 server that specifies how 
to connect to the database and locate data and which oracle application server to use. 

When installing an Agile e6.1.1 server, the installation program automatically creates a default 
application which will be configured during the installation, and the application name will be 
associated with the database. 

It is also possible to create additional applications within the same installation, thus it is not 
necessary to maintain separate installations for different purposes. A single Agile e6.1.1 installation 
often includes separate applications for various purposes, such as testing (for testing purposes 
before creating the actual working applications), development, production, and education. 

The applications created for an installation can be associated with the same or with different 
databases (e.g. a multi-environment system, in which development and test environments, and their 
respective databases, co-exist with a production environment and its database). In general it is 
recommended to have a separate production infrastructure to avoid risk of loss of production by 
changing something in e.g. the development environment. 

About Agile e6.1.1 Business Services Administration 
When creating an Agile e6.1.1 application, the Business Services component will be 
installed/deployed on your oracle application server for each new application. The Business 
Services comprises of the Workflow Module. 

Overview of the Workflow Module 

To include Workflow processes in an Agile e6.1.1 application, optional configuration parameters can 
be defined for the processes within the overall Agile e6.1.1 application definition. For more 
information, refer to the chapter Administrate Agile e6.1.1. 

Note  For further information on using the Workflow module, refer to the Agile e6.1.1 Online 
Help > Using Agile e6 > Product Data Management > Workflow. 
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Make Modification without the Administration Client 

Note  Any file or configuration modification made without the Administration Client will be lost 
during a patch upgrade, or by changing the application values with the Administration 
client again. 
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Chapter 2  

Administrate Agile e6.1.1 
The Agile e6.1.1 Administration client lets you create, configure, and delete Agile e6.1.1 
applications via the web browser. Agile recommends that you use a supported browser (see 
Prerequisites Guide for Agile e6.1.1) to connect to the Administration client. 

Note  If the following window opens, you might have to add the Administration client to the 
trusted web sites in your browser settings: 

 

Administration Client 
The Administration client will be installed automatically with the Installer if you install a server 
component. It can be used to create new or modify existing applications. The Administration client is 
a web based application and is deployed in an Apache Tomcat servlet container. For detailed 
information on Apache Tomcat servlet container refer to http://tomcat.apache.org/ . Currently we are 
using Apache Tomcat v6.0.16. 

You can find Apache Tomcat in: 

 Windows: %ALLUSERSPROFILE%\agile\installer\6.1\admin  

 Unix: $HOME/agile/installer/6.1/admin. 
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Start the Administration Client 
 Windows:  

Start the service "Apache Tomcat AdminClient" and set the startup type to "Automatically".  

 Unix: 

Use the standard apache tomcat startup and stop scripts.  

A 32bit Java 5 version has to be used. On most new Unix servers the default java version is a 
64bit java. 
1. To set the 32 Bit Java 5 for Tomcat create the file "setenv.sh" in the 

$HOME/agile/installer/6.1/admin/apache-tomcat/bin directory of tomcat with a line like: 
export JRE_HOME=/usr/local/java/jdk1.5/jre 
2. Tomcat will automatically use this java version which must point to a 32 bit Java. 
3. Start Tomcat with "startup.sh". Stop Tomcat with "shutdown.sh". 
Tomcat will show the used Java version at startup with something like: 
Using JRE_HOME:       /usr/local/java/jdk1.5/jre 

Change the Password 

The Administration client has a default password which has to be changed after the Agile e6.1.1 
installation.  

 The encrypted password for the admin client can be found in: 
 Windows:  

%ALLUSERSPROFILE%\agile\installer\6.1\admin\apache-
tomcat\webapps\AdminClient\metadata\Adminserver_Props.txt 

 Unix:  

$HOME/agile/installer/6.1/admin/apache-
tomcat/webapps/AdminClient/metadata/Adminserver_Props.txt. 

 To create a new password execute:  
 Windows:  

%ep_root%/axalant/cmd/epkeytool.bat -encryptpwd -pass <password> -keyStore 
cwallet.sso -keyAlias "C=DE,ST=Baden,L=Karlsruhe,O=Oracle,OU=Agile PLM,CN=PLM" 

 Unix:  

$ep_root/axalant/scripts/epkeytool.sh -encryptpwd -pass <password> -keyStore 
cwallet.sso -keyAlias "C=DE,ST=Baden,L=Karlsruhe,O=Oracle,OU=Agile PLM,CN=PLM" 

The resulting output is your encrypted password. Change the property “password” in the 
“Adminserver_Props.txt“ file with the newly generated password, and restart the Apache Tomcat 
process.  

Chapter 2 - 4 Oracle® Agile Engineering Data Management 

 



Administration Manual for Agile e6.1.1  
 

Change the Apache Tomcat Configuration 

Tomcat is configured with a HTTP connector by default. 

Note   Administration client uses port 8030 for the HTTP connector.  

If you want to change this port you have to edit the Apache Tomcat “conf/server.xml” file and restart 
the Apache Tomcat process. If you want to enable HTTPS for the Administration client please refer 
to http://tomcat.apache.org/tomcat-6.0-doc/ssl-howto.html for more information. 

Administration with the Administration Client 

Login/Logout 

1. Access the Administration Client via http://<servername>:8030/AdminClient. 

The login site is opened. 

 

2. Login with the following parameters: 

 User: plm 

 Password: e.g. “ChangeOnInstall” or your new generated password  

The Welcome site is opened. 
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The navigation at the left hand side shows under ‘Components’ all available installations that 
can be configured. 

Under ‘References’ the available database clients, databases, and application server can be 
found. 

3. To logout click the “Logout” link in the upper left corner. 

Note  The Administration client will timeout after 10 minutes, after that you have to login again. 

Create/Modify an Application 

1. Under <installation name> -> Application click create. 

The Application Input Form is opened. 
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2. Create a new application with the following parameters: 

Application Input Form 

Set t ing  Descr ipt ion 

Name The name of the default application you want to create (former axalantORIGIN) 

Database User The database user you want to use for the application. 

Database Password The password of the database user. 

Verify Password The password entered above has to be repeated for verification. 

Http Host The host where the web client is running (the application server host name). 

Http Port The port where the web client is running (the HTTP(s) port of your application server). 

ECI Port The port where the business service will be configured to “wait” for requests (default: 
19998). 

Mailserver If you want to send emails with the business services, define the name of your SMTP 
mailserver. 

Admin UIC The UIC of an Agile e6.1 user to whom administrative emails should be send to. 

Import DB Dump Select if you want the standard dump to be imported to the above defined database user. 

Create DB User Select if you want the database user to be created automatically. 

SYSTEM Password Password of the System (Administrator) Oracle database user. 

Note  You only have to apply a value here if you want to create a new 
database user and selected that in the field above.  
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Admin Password Password of the oracle application server user defined in the referenced application server. 
(Normally the password of the “oc4jadmin” user.) 

References 

Note  Here you can define which Database and Application server should be used for this 
application. (Normally these values do not have to be changed.) 

Set t ing  Descr ipt ion 

Application Server The name of the reference of the application server where the components like the business 
service will be deployed. 

Database The name of the reference of the database you want to use for the application. 

Note  Creating a new application can take up to 5 minutes, depending on if a database user 
will be created and the database dump for the application has to be imported.  

3. Click Create. 

Update/Delete an Application 

1. To update an application click “<application name>” under <installation name> -> Application -> 
Modify. 

This opens the following site: 
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Here you can see the current values of your application. 

It is possible to delete the application with the “Delete” Button in the upper left corner. 

Note  Deleting an application will not remove the business service from the Oracle Application 
Server, this must be done manually with the Oracle Application Server control web 
interface. Also, the used database schema remains unchanged. 

2. Click the “Edit” Button in the upper left corner to change the values for the application. 

This opens the following site: 

 

In this example the value of the mail server has been changed. To apply the changes, press 
the “Update” button in the upper right corner. The admin server will delete your current 
application and create a new one with the new values. Also the business services will be 
redeployed with the new values. All changes made for the business service directly on the 
Oracle Application Server are lost. 

Note  All manual changes of your application which are not applied over the Administration 
client will be lost.  

Note  To update a production application that is in use and running is NOT recommended. 
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Set and Change Initial User Passwords in a New Agile 
e6.1.1 Application 

Note  The enhanced security module is enabled in each newly created application (with a new 
dump) by default. You can only login to this application with the user "manager"! 

Perform the following steps: 

1. Start a e6.1.1 Client and login to your application with user "manager" with password 
"manager" 

2. For the first login you are asked to set a new password for this user. This will be the password 
for the future logins. 

3. All other users are deactivated and have to be activated y setting a new valid password. 

Set the password for user "EDBCUSTO" and all other standard users 

1. Open the User List: Manager > Permissions > User > Basic Data 

2. Set the password: Refresh > Select "EDBCUSTO" > Context Menu: Set Password 

Note  At the first login of user "EDBCUSTO" with the initial password the user will be asked to 
set a new password. This will be the password for the future logins. 

Repeat these steps for all newly created, and standard users. 
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Chapter 3  

Managing References 

Add a New Database to Use for an Application 
Requirements for a new database: 

 Create a new database connection 

 Define a new database server 

Will be connected over the previously defined database connection. 

 SQLNet has to be configured already and working  

1. To define a new database connection, click on “create” under References > Database 
Connection. 

This opens the following site: 

 

2. Create a new database connection with the following parameters: 

Set t ing  Descr ipt ion 

Name The new name which identifies the connection 

Client Home The Oracle Client Home directory 

SQLNet Connect The SQLNet connect string as defined, e.g. tnsnames.ora 

3. Click Create in the upper right corner. 

4. To define a new database server click on “create” under References > Database Server 
Definition. 

This opens the following site: 
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5. Create a new database server with the following parameters: 

Set t ing  Descr ipt ion 

Name The new name which identifies the database definition 

Host Name The host name of your database server. 

SID The SID of the database you want to connect to. 

Port The port where the listener listens on the database server. 

6. Click Create in the upper right corner. 

Add a New Application Server to Use for an Application 
7.  To define a new application server click “create” under References > Application Server. 

 

8. Create a new application server with the following parameters: 
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Set t ing  Descr ipt ion 

Hostname The hostname of your application server. 

ORMI Port The ORMI port on which the application server can be accessed (6003 is the standard Oracle 
Application Server port for that). 

Admin ID The username of a user on the application server which is allowed to deploy applications. ( 
Default user is oc4jadmin) 

9. Click Create in the upper right corner. 

Delete a Reference 
1. To delete a reference (Reference Database Connection/Database Server Definition/Application 

Server) expand the “Modify” node of the corresponding reference and select the name of the 
reference.  

2. Click Delete in the upper left corner. 

This will only delete the reference in the “installation_prop.xml” file if the reference is not in use. 
If it is in use an error message is displayed.  

Note  Nothing else will be deleted!  
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Chapter 4  

Advanced Administration Tasks 

Agile e6.1.1 and Oracle Application Server 

Note  In this document, replace <installation_name> with your installation name (e.g. 
AgileInstallation61). 

The Oracle Application Server is mandatory for Agile e6.1.1. After the Agile e6.1.1 installation, the 
Web Client, Java Client Web Start, PLMAPI (HTTP support), the Web Fileservice have to be 
available. Additionally, for each created application a Business service has to be available. 

To verify this, login to your Oracle Application Server. The following applications have to be 
available (e.g. http://example.com:7777/em/console/ias/oc4j/applications (your oracle application 
server name and http port)): 

 Java Client Web Start: 

Jacc<installation_name> 

 PLMAPI:  

plmapi<installation_name> 

 Business Services:  

BusinessService<application name> 

 Web Client:  

Agile e6 <installation_name> WebClient webplmenv 

 Web Fileservice:  

Agile e6 <installation_name> WebFileservice 

The following context roots of these applications (except the Business Service and WebFileservice) 
have to work.  

Note  Use your Oracle Application Server name and http port. 

 http://example.com:7777/WebClient_<installation_name>_webplmenv/ 

Web client start link 

 http://example.com:7777/Jacc<installation_name>/jacc.jnlp  

Java client web start 

 http://example.com:7777/plmapi<installation_name>/services  

plmapi services page 
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Further information on Oracle Application Server administration can be found under the Oracle 
Application Server documentation http://download.oracle.com/docs/cd/B31017_01/index.htm. 

Agile e6.1.1 Business Service Administration 
Business Services are always installed/deployed if a new application is created with the 
Administration client. Therefore, the availability of the application server is mandatory. 

If you want to perform additional changes to the Workflow module, as described in the Manager 
Information of the Workflow module online help, you have to edit the configuration file for the 
Business Services on the Oracle Application Server directly. You can find the 
“ABS_<application_name>.ini” file at <oracle application server home> 
\j2ee\home\applications\BusinessService<application_name>\<application_name>Web\WEB-
INF\ABS_<application_name>.ini. 

The definition of the JDBC database connection can be found in the web module of the Business 
Service at <oracle application server home> 
\j2ee\home\applications\BusinessService<application_name>\<application_name>Web\WEB-
INF\web.xml. 

If manual modifications have been made to these files, the Oracle Application Server application 
has to be restarted to use the modified values. 

Note  Changing values with the Administration Client for an application will overwrite your 
manual changes! 

The Business Services will connect to the defined database user/schema directly after they are 
started in the Oracle Application Server. 

Note  Once this connection was lost due to e.g. a database reboot, dropping the database 
schema, loss of service, you have to restart the business service inside the Oracle 
Application Server. 

Note  It is also possible to restart the complete Oracle Application Server, but all included 
services will not be available for that time.  

About Agile e6.1.1 Web Client Administration 
The e6.1.1 Web client is always installed/deployed if a new Agile e6.1.1 server installation is 
created. The Web client allows starting all created applications of the installation. The Web client for 
your installation can be accessed via e.g.  

Note  Use your Oracle Application Server name and http port. 

http://example.com:7777/WebClient_<installation_name>_webplmenv/ 

On the file system the WebClient can be found on the Oracle Application Server at <oracle 
application server home>\j2ee\home\applications\Agile e6 <installation_name> WebClient 
webplmenv. 
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Note  If you have made modifications to the Web client you have to restart the Oracle 
Application Server application to use the modified values. 

Note  It is also possible to restart the complete Oracle Application Server, but all included 
services will not be available for that time.  

About PLMAPI/ HTTP(S) Support 
PLMAPI allows the communication to the Agile e6.1.1 application server through firewalls (via http). 
It is only supported in the java client. For further information on the architecture refer to the 
‘Architecture Guide for Agile e6.1.1’ documentation. 

The plmapi is always installed/deployed if a new Agile e6.1.1 server installation is created and can 
be used for all created applications of the installation. To be able to use the plmapi, it has to be 
configured in the Java client. To use the plmapi, no changes are necessary in the configuration of 
the Oracle Application Server. 

For further information on how to setup HTTP(S) support in the java client refer to the ‘Preferences’ 
document in the “Getting Started” section in the online help, and the Architecture Guide.  

Special Batch Installation Tasks 

Create an Application in Batch Mode 

Note  Agile e6.1.1 has to be installed! 

1. Change to directory (if not available create the "properties" directory): 

 Windows: 

%ALLUSERSPROFILE%\agile\installer\6.1\properties 

 Unix: 

${HOME}/agile/installer/6.1/properties 

2. Create the properties file for the application to be created: 
 # application parameters 

plm.application.name=mytest 

plm.application.dbpassword=mytest 

plm.application.dbuser=mytest 

plm.application.dbpoolminsize=4 

plm.application.dbpoolmaxsize=10 

plm.application.httphost=khe-vidal-eng3 

plm.application.httpport=80 

plm.application.eciport=19998 

plm.application.adminuic=200 

plm.application.mailrelay=mymailserver 
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# Defines if reference dump will be imported 

plm.application.dumpimport=true 

# Defines if the schema will be created (system password also has to 
be applied for creating a schema) 

plm.application.creschema=true 

# Defines if the content of an existing schema will be deleted 
(Attention: All objects of the defined schema will be lost)? 

plm.application.delschemaobj=false 

# Database to import as defined in installation_prop.xml (normally no 
need to change this) 

plm.application.databasedefinition=ora111 

plm.oracle.systempwd=ChangeOnInstall 

# Application server to deploy as defined in installation_prop.xml 
(normally no need to change this) 

plm.application.applicationserverdefinition=oc4j_10133 

plm.applicationserverdefinition.adminpass=welcome1 

3. After defining the properties go one directory up and execute: 

 Windows:  

setup.cmd application.install -Dplm.installer.setup.prop.file=properties/mytest.properties -
Dplm.inst.name=AgileInstallation61 -Dplm.isAdminClient=true 

 Unix:  

setup.csh application.install -Dplm.installer.setup.prop.file=properties/mytest.properties -
Dplm.inst.name=AgileInstallation61 -Dplm.isAdminClient=true 

 (Re)Deploy Business Services for an Application in Batch Mode 

Redeploying a Business Service causes a recreation of the Business Service ‘ear’ file and the 
deployment to the application server with the configured values as defined the installation_prop.xml 
file.  

Note  Agile e6.1 has to be installed! 

1. Change to directory: 

 Windows:  

%ALLUSERSPROFILE%\agile\installer\6.1 

 Unix:  

${HOME}/agile/installer/6.1 

2. Execute: 

 Windows: 

 setup.cmd application.businessservices.deploy -Dplm.inst.name=AgileInstallation61 -
Dplm.application.name=plmref -
Dplm.applicationserverdefinition.adminpass=myapplicationserverpassword 

 Unix.  
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setup.csh application.businessservices.deploy -Dplm.inst.name=AgileInstallation61 -
Dplm.application.name=plmref -
Dplm.applicationserverdefinition.adminpass=myapplicationserverpassword 

(Re)Deploy Java Client Web Start ear File in Batch Mode 

Redeploying the Java client causes a deployment of the Java client ‘ear’ file to a specified 
application server. 

Execute: 

 Windows:  

setup.cmd javaclientear.install -Dplm.inst.name=AgileInstallation61 -
Dplm.applicationserverdefinition.nodename=oc4j_10133 -
Dplm.applicationserverdefinition.adminpass=myapplicationserverpassword 

 Unix:  

setup.csh javaclientear.install -Dplm.inst.name=AgileInstallation61 -
Dplm.applicationserverdefinition.nodename=oc4j_10133 -
Dplm.applicationserverdefinition.adminpass=myapplicationserverpassword 

(Re)Deploy Web Client ear File in Batch Mode 

Redeploying the Web client causes a deployment of the Web client ‘ear’ file to a specified 
application server.  

Execute: 

 Windows:  

setup.cmd webpresentationservice.redeploy-Dplm.inst.name=AgileInstallation61  -
Dplm.webpresentationservice.nodename=webplmenv -
Dplm.applicationserverdefinition.adminpass=myapplicationserverpassword 

 Unix:  

setup.csh webpresentationservice.redeploy-Dplm.inst.name=AgileInstallation61  -
Dplm.webpresentationservice.nodename=webplmenv -
Dplm.applicationserverdefinition.adminpass=myapplicationserverpassword 

(Re)Deploy plmapi ear File (HTTP Support) in Batch Mode 

Redeploying plmapi causes a deployment of the plmapi ‘ear’ file to a specified application server. 

Execute: 

 Windows:  

setup.cmd plmapiear.install -Dplm.inst.name=AgileInstallation61 -
Dplm.applicationserverdefinition.nodename=oc4j_10133 -
Dplm.applicationserverdefinition.adminpass=myapplicationserverpassword 

 Unix:  

setup.csh plmapiear.install -Dplm.inst.name=AgileInstallation61 -
Dplm.applicationserverdefinition.nodename=oc4j_10133 -
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Dplm.applicationserverdefinition.adminpass=myapplicationserverpassword 
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Chapter 5  

RAC Support 
This section describes the needed modifications to an Agile e6.1 installation including deployed 
BusinessServices to support a RAC database. It is recommended to do the RAC database setup 
and e6.1 adaptions with the help of an oracle consultant. 

Prerequisites 

RAC database is running, Oracle consulting has approved the RAC database installation. 

The RAC database is configured on the oracle client side where the e6 server is running. Needed 
adaptions in tnsnames.ora, sqlnet.ora are available. 

Oracle Application Server is installed and running. 

Install e6.1 as described in the installation manual with the following settings.  

In the “Installer Components” mask select “Reference to existing Database” and “Reference to 
existing Application Server”. 

In the “Reference Configuration” mask you have to set the following entries: 
As “SQLNet Connect” add the entry of your RAC database from tnsnames.ora. 
As SID select one SID of an Instance of your RAC database. 
As “Host Name” add the virtual hostname of the Instance configured as SID. 

 
The following picture shows an example configuration.  
 

 

Check your Installation with these settings. 
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Installation Adaptions 

Update SQLNet Connect String used for Business Services 

The Business Services are using a data source to connect to the RAC database. The data source 
definition needs to be changed. 

Following steps need to be done: 

 Stop oracle application server 

 Copy your RAC aware tnsnames.ora, sqlnet.ora of your oracle client installation to 
<OAS_HOME>\NETWORK\ADMIN\ 

 Open <OAS_HOME>\j2ee\home\applications\BusinessService<application>\META-INF\data-
sources.xml in an editor. 

 Replace the URL 
jdbc:oracle:oci:@(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=examplevip1.com)(
PORT=1521))(CONNECT_DATA=(SERVER=DEDICATED)(ORACLE_SID=plm611))) 
with: 
jdbc:oracle:oci:@plm61 
where “plm61” is the SQLNet Connect String from tnsnames.ora which must be “RAC aware”. 

 Start oracle application server 

Note  Every time a new application is created/updated with the admin client or in batch mode 
you have to replace the URL manually. 
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Chapter 6  

Java Client 

Predefined Java Client connection settings 
When starting the Agile PLM Client the client following connection settings can be passed 

-a <Application Name> 

-h <Host Name> 

-d <Daemon number> 

-p <ECI port> 

-u <PLM Username> 

Java Client Native Installation Windows example: 

- Open properties for the shortcut “Agile e6.1 Java Client.lnk” in “C:\Documents and 
Settings\All Users\Start Menu\Programs\”  

- At the end of the “Target” Attribute add connection setting you want to use e.g.: 
-a plmref -h example.com 

- It is also possible to edit the “jacc.cmd” file in “C:\Documents and Settings\All 
Users\Application Data\Oracle\Agile\EDM“ and to add the setting there. Search the line 
which ends with “…com.agile.jacc.e6.Jacc %* “ and replace this like  e.g.: 
“…com.agile.jacc.e6.Jacc %* -a < Application Name > -h <Host name>…” 
 

Java Client Web Start example: 

- Open <oas_home>\j2ee\home\applications\JaccAgileInstallation61\Jacc\jacc.defaults 

- Adapt the properties you need:  
jacc.node, jacc.port, jacc.app .. 

Java Client DFM side definition 
To configure the Java Client to start with a specific DFM side you have several options which are 
read in the order given here. The first occurrence will set the variable EP_DDM_SITE: 

1) Edit the “jacc.cmd” file in “C:\Documents and Settings\All Users\Application 
Data\Oracle\Agile\EDM“ and to add the setting there. Search the line where “javaw” is 
executed and add e.g.: -DEP_DDM_SITE="ka”. The line looks then like this: 
“"%JAVA_HOME%\bin\javaw.exe" %VM_OPTS% -Djacc.home="$APPDATA\e61" -
DEP_DDM_SITE="mu" ….” 

2) Open <oas_home>\j2ee\home\applications\JaccAgileInstallation61\Jacc\jacc.jnlp add the 
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line<property name="EP_DDM_SITE" value="sitejnlp"/> 

3) Add the entry “EP_DDM_SITE=ka” to $APPDATA\Agile\e61\jacc.ini e.g.: “C:\Documents 
and Settings\<username>\Application Data\Agile\e61\jacc.ini”. The jacc.ini file is available 
after the first exit of the JavaClient. Do not edit the file while the client is running or your 
setting will be overwritten. 

4) Open <oas_home>\j2ee\home\applications\JaccAgileInstallation61\Jacc\jacc.defaults add 
add a line: EP_DDM_SITE=ka 

5) Set an environment variable “EP_DDM_SITE=ka” 

Number 1 does only work for Java Client Native installations, 

Number 2 does only work for Java Client Web start installations. 

By applying multiple jnlp files on the oracle application server with different site entries it is 
possible to provide a web start environment for different EP_DDM_SITE’s with one single 
deployed Java Client. 

To verify the current Java Client EP_DDM_SITE setting create a LGV Procedure with the following 
line: 

put(client_env("EP_DDM_SITE")) 

and execute the LGV procedure. If the setup is correct you will see the defined site as output in your 
client message window. 
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Chapter 7  

Secure Environment (HTTP(s) Support) 

Prerequisites 
Before starting to setup a secure environment make sure your standard installation as described in 
the installation documentation works without issues.  

In the secure environment we will just make some modifications to a standard environment. To 
configure the secure environment you need a certificate from a trusted certificate authority. 

Secure External Communication 
In Agile e6.1.1 it is possible to setup external access to the Agile e6.1.1 environment with the Java 
client or a Web Browser using the WebClient. It is possible to setup the complete external 
communication over internet using the HTTPS protocol. 

This section describes how to setup a secure environment for this use case.  

External communication means the communication from a Java/Web client over the internet to the 
Agile e6.1.1 http server which is the Oracle HTTP Server of the Oracle Application Server. 
Following picture illustrates an example communication. 
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As you can see in the above picture the Java/Web client connects to the Oracle Application Server 
over the oracle http server. 

In the secure environment the PLMAPI on the Oracle Application Server "receives" all incoming 
requests from the Java client on the Oracle Application Server. 

The Web client on the Oracle Application Server will "receive" all incoming requests from Web 
Client application in the Web Browser. 

You have to adapt the Oracle Application Server (Oracle HTTP Server), the Java client and the 
WebFileService to use https communication. 

Note  Setting up the Proxy or other DMZ infrastructure is not part of this document.  

Setup https on the Oracle Application Server 
By default, the Oracle HTTP Server is configured with SSL and the SSL certificate store, which is 
located at $ORACLE_HOME\Apache\Apache\conf\ssl.wlt\default\. 

The listen parameter in the $ORACLE_HOME\Apache\Apache\conf\ssl.conf file points to the SSL 
port being used by the Oracle HTTP Server. The default certificate store 
$ORACLE_HOME\Apache\Apache\conf\ssl.wlt\default\ewallet.p12 is being used by the Oracle 
HTTP Server. This default certificate store cannot be used for the Agile e6.1.1 environment. For 
using HTTPS in an Agile e6.1.1 environment you have to get a certificate from a trust center first. 
Security administrators use Oracle Wallet Manager to manage public key security credentials. 

The Oracle Wallet Manager is part of your Oracle 11g database installation. A detailed description 
of the Oracle Wallet Manager can be found in "Oracle® Database Advanced Security 
Administrator's Guide 11g Release 1 (11.1)" of your Oracle 11g database documentation. 

The following steps provide an overview of the complete wallet creation process and give a short 
description on how to use the Oracle Wallet Manager (the used values are examples and cannot be 
used to get trusted certificate from a CA). 

1. Start the Oracle Wallet Manager: 

 Windows: 

Select Start > Programs > Oracle-HOME_NAME > Integrated Management Tools > Wallet 
Manager 

 UNIX: 

At the command line as user oracle, enter owm. 

Chapter 7 - 26 Oracle® Agile Engineering Data Management 

 



Administration Manual for Agile e6.1.1  
 

 

2. To create a new wallet select Wallet > New. 

3. Enter a password for your wallet and click OK. 

Note  Keep this password in mind. 

You will be asked if you want to create a certificate request. 

4. Click OK. Next, you have to enter your information. 

 

5. Click OK. 

Now you have created the certificate request. 
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6. Save your wallet configuration with Wallet > Save. 

7. Send the certificate request to the CA you want to use. 

8. After you have received your signed user certificate you can import it into your wallet with 
Operations > Import User Certificate… 

 

9. Replace the $ORACLE_HOME\Apache\Apache\conf\ssl.wlt\default\ewallet.p12 file with your 
newly created one and restart your Oracle Application Server. 
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Test the Configuration. 
1. Now, HTTPS is enabled in your Oracle Application Server. To find out which HTTPS port is 

used execute: 
$ORACLE_HOME\opmn\bin\opmnctl status -l 

Normally the HTTPS port should be 4443. 

2. Open the following link: 
https://<fully qualified server name>:4443 

e.g. https://example.com:4443 

This should now open the web page without security warnings. 

3. Check the HTTP support deployment with the following link: 
https://<fully qualified server name>:4443/plmapi<your installation 
name>/services 

e.g. https://example.com:4443/plmapiAgileInstallation61/services 

This shows the PLMAPI Services page. 

4. To start Java Client Web Start: 
https://<fully qualified server name>:4443/Jacc<your installation 
name>/jacc.jnlp 

e.g. https://example.com:4443/JaccAgileInstallatione61/jacc.jnlp 

This should start the Java Client webstart. 

Setup the Java Client 
To enable https support in the JavaClient you have to activate/change the HTTP/S support setting. 

1. Open the Java client. 

2. Open the Preferences mask.  

3. Enable the HTTP/S support and change/add the Server URL and Service name to: 
Server URL: https://<fully qualified server name>:4443 

Service name: plmapi<your installation name>/services 

Following picture shows an example configuration: 
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Java Client with Proxy 

By default the Java client uses the proxy configuration of your java environment. This is configured 
on the client side in the Java Control Panel (e.g. open MS Windows control panel > Java) on the 
General Tab open the “Network Settings…” 

Note  Depending on your proxy configuration, one of the proxy settings has to be selected. 
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Setup the Web Fileservice  
To enable https support for the Web File Service the Web address in the vault configuration has to 
be changed. 

Start the Java client with a manager user and select Manager > File Management > Vaults. 
Protocol: https 
Host: <fully qualified server name> 
Port: 4443 
Path: /WebFileservice_<your installation name> 
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Web File Service with Proxy 

The Web File Service does not use the proxy configuration of your Java environment. The proxy for 
the Web File Service has to be configured in the Java client preferences. 
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Setup the WebClient 
No configuration changes have to be done if you want to use the Web client with https. 

Just use the HTTPS protocol and port in your browser. 

The WebFileservice adaptions in the dump also have to be done (see above) to use file checkin/out 
in the WebClient with https. Proxy configuration will be used from the browser. 
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Chapter 8  

Authentication 

LDAP Support  
LDAP (Lightweight Directory Access Protocol) is an application protocol for querying and modifying 
directory services running over TCP/IP. 

With Agile e6.1.1, LDAP-based authentication is supported. While a PLM user is logging on to the 
PLM system (through any supported client), the password of that PLM user is checked against an 
LDAP repository instead against the password which is normally stored in the PLM database. 

The communication between the PLM server and the LDAP repository has to be set up. Every PLM 
user, as configured in the PLM database, has to exist in the LDAP repository in order to be 
authenticated upon login. 

Note  Although LDAP support helps in needing only ONE password for many different 
systems, this should not be mistaken with automatic Single-Sign-On (SSO) support, 
which would allow a user to log on automatically without even being asked to provide 
user login and password! 

Prerequisites 
 LDAP server (Oracle Internet Directory / MS Active Directory / other LDAP server) 

 Oracle LDAP client (part of the Oracle client installation) 

 The LDAP user name has to be the same as the PLM user name  
(e.g. LDAP user : cn=TESTUSER ; cn=users ; dc=agile ; dc=com 
PLM user : TESTUSER) 

User Authentication via LDAP 

A LDAP directory is often used to manage users and organization units in a central environment. 
The Microsoft Active Directory organizes users and groups within a Windows Domain. Products like 
the Oracle Internet Directory are able to manage users, groups and organization units in a standard 
LDAP environment and are compatible with the most other LDAP servers which are based on the 
LDAP standards.  

With Agile e6.1.1 it is possible to authenticate a PLM user by using an LDAP service. 

The LDAP for Agile e6.1.1 uses the Base-DN for a direct access path to authenticate the user. 
LDAP does not support relative search paths. 

Setup an LDAP User 

To change the authentication mechanism of a user, select the “LDAP” type in the user list of Agile 
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PLM e6.1.1.  

The LDAP system takes care of the password policies (expiration and format).  

Note  The enhanced security module and the possibility to change the password within PLM 
are deactivated for LDAP users. 

Configuration 

The LDAP configuration used by the PLM system is stored in the database as configuration 
parameters (T_CFG_DAT). 

Name Defaul t  Va lue  Descr ipt ion 

EDB-LDAP-HOST <LDAP-host> LDAP host name 

EDB-LDAP-PORT - LDAP service port (=default port depends on 
encryption mode) 

EDB-LDAP-BASEDN cn=users, dc=agile, dc=com Base DN of the user group 

EDB-LDAP-ENCRYPTION Yes LDAP encryption mode (yes=SSL, no=clear text) 
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Chapter 9  

Office Suite - PDF Generator Installation 

Note  Further information about how to install he Office Suite can be found in the document 
Installation Manual for Agile e6.1.1 Client on Windows. 

One main feature of the Office Suite is the PDF generation from a MS Office file. The Office Suite 
supports a PDF printer to convert Office documents into PDF files. 

The Office Suite PDF Service is a MS Windows Service and does not need any GUI.  

Installation 
1. Extract the installation package to your installation directory. 

The installation package of the Office Suite PDF Service is located on the package directory 
and named officesuitepdf.zip. 

In this example the installation path is "C:\Program Files\Agile_e6\Office-Suite-PDF" (the 
Office-Suite-PDF path is the base path in the package). 
unzip z:\package\officesuitepdf.zip -d "c:\Program Files\Agile_e6" 

The installation package contains the following directories: 
-> PDF Service Root        (C:\Program Files\Agile_e6\Office-Suite-
PDF) 

 -> axalant 

    -> cmd                 (scripts directory) 

    -> pdf                 (PDF service files) 

    -> bin 

      -> intel-ms-nt5.0    (binaries like the FMS-Client) 

      -> java              (e6.1 Java archives) 

 -> ext 

    -> bin 

      -> intel-ms-nt5.0    (external binaries) 

      -> java              (external Java archives) 

 -> tmp                    (Logging directory) 

2. Adapt the installation. 

You need to adapt the start-up script to setup the Java-Runtime and the installation path of the 
Office-Suite PDF Service. The script is located at the …\axalant\cmd sub directory of the 
installation.  

The pdf.bat script contains the following basic configuration settings:  
set JAVA_HOME=<JAVA_HOME> 

set ep_root=<ROOT DIRECTORY OF THE OFFICE SUITE PDF SERVICE> 

Example:  
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set JAVA_HOME=C:\Program Files\Java\jdk1.5.0_16 

set ep_root=C:\Program Files\Agile_e6\Office-Suite-PDF 

3. Adapt the service settings. 

The OfsPdf.properties file is located at the axalant/pdf sub directory of the installation. This file 
sets the environment variables needed by the Office Suite PDF Service. 

The following properties have to be adapted. 

Note  The other properties should not be changed! 

# 

# ECI connection 

# 

host=<HOSTNAME OF THE ECI DAEMON> 

port=<PORT OF THE ECI DAEMON> 

env=<PLM APPLICATION ENVIRONMENT> 

# 

# Directories 

# 

varenv.DATAVIEW_CROO=<BINARIY DIRECTORY OF THE PDF SERVICE> 

varenv.ep_root=<ROOT DIRECTORY OF THE PDF SERVICE> 

varenv.axalant_root=<AXALANT DIRECTORY OF THE PDF SERVICE> 

varenv.$TMP=<PDF WORK DIRECTORY OF THE PDF SERVICE> 

# 

# Host names 

# 

varenv.CLI_HST=<NAME OF THE PDF SERVICE MACHINE> 

varenv.CLI_SRV=<NAME OF THE PLM SERVER MACHINE> 

# 

# PLM Client 

# 

client1=<PLM USER>,<PASSWORD>,office.pdf.OfsPdf 

Example:  
# 

# ECI connection 

# 

host=khe-plm 

port=20001 

env=plm_ref 

# 

# Directories 

# 

varenv.DATAVIEW_CROO=C:/Program Files/Agile_e6/Office-Suite-
PDF/axalant/bin/intel-ms-nt5.0 

varenv.ep_root=C:/Program Files/Agile_e6/Office-Suite-PDF 

varenv.axalant_root=C:/Program Files/Agile_e6/Office-Suite-PDF/axalant 
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varenv.$TMP=C:/officesuite/PDF_generation 

# 

# Host names 

# 

varenv.CLI_HST=pdfsrv 

varenv.CLI_SRV=khe-plm 

# 

# PLM Client 

# 

client1=DEMOEP_M,not4test,office.pdf.OfsPdf 

Note  The PDF work directory has to be created and entered in the PLM server 
configuration, PDF Service, and the PDF printer. 

Office Suite PDF Service 
The Office Suite PDF Service uses the same mechanism as the Java-Daemon to install, remove, 
start, and stop the service. 

It can be either installed as a Windows Service or run as a console application. 

Install as Windows Service 

Note  The PDF Generator can be installed with the Windows Installer tool. After the PDF 
Generator is installed, an extra service is added to the Services list. Agile PLM Office 
Suite PDF (Control Panel > Administrative Tools > Services). 
The Agile PLM Office Suite PDF Service is a MS Windows Service and does not need 
any GUI. 

The configuration of the Windows Service registration can be found in the pdf_wrapper.conf file 
which is located in the …\axalant\pdf sub directory of the installation. 
#******************************************************************** 
# Wrapper NT Service Properties 
#******************************************************************** 
# WARNING - Do not modify any of these properties when an application 
#  using this configuration file has been installed as a service. 
#  Please uninstall the service before modifying this section.  The 
#  service can then be reinstalled. 
 
# Name of the service 
wrapper.ntservice.name=Agile PLM Office Suite PDF Service 
 
# Display name of the service 
wrapper.ntservice.displayname=Agile PLM Office Suite PDF Service 
 
# Description of the service 
wrapper.ntservice.description=PDF Generator for Agile PLM 

Oracle® Agile Engineering Data Management Chapter 9 - 39

 



Administration Manual for Agile e6.1.1  
 

 
# Service dependencies.  Add dependencies as needed starting from 1 
wrapper.ntservice.dependency.1= 
 
# Mode in which the service is installed.  AUTO_START or DEMAND_START 
wrapper.ntservice.starttype=AUTO_START 
 
# Allow the service to interact with the desktop. 
wrapper.ntservice.interactive=false 
 
wrapper.ntservice.account=.\axalantrt 
wrapper.ntservice.password=******** 

To install the Office Suite PDF Service as Windows Service use the pdf.bat command script located 
in the …\axalant\cmd sub directory of the installation. 
pdf.bat –i 

Remove the Service 

To uninstall the Office Suite PDF Service as Windows Service use the pdf.bat command script 
located in the …\axalant\cmd sub directory of the installation. 
pdf.bat –r 

Run as Console Application 

To run the Office Suite PDF Service as console application use the pdf.bat command script located 
in the …\axalant\cmd sub directory of the installation. 
pdf.bat –c 

Configuration 
The Office Suite needs some information to access the PDF printer and to exchange the files. 

Printer Setup 

The PDF printer has to fulfill the following prerequisites: 

 Generate PDF file without user interaction (pure batch printing) 

 Configurable PDF output folder 

 Possibility to create a <PDF-Filename>.log file in the PDF output folder, after PDF file creation. 

Note  The PDF Output Folder is the exchange folder between the PDF printer and Agile e6.1.1. 

Note  Any folder can be used, but the configuration of the PDF printer has to match the 
configuration of the Agile PLM Office Suite PDF Service. 
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Post PDF creation script 

Prerequisite for PDF printer is the <PDF-filename>.log file creation ( see above ) in the PDf output 
folder. This file is the “Ready” file for the batch client to trigger the PDF file checkin. 

If your PDF printer does not create a <PDF-filename>.log file per default, there exists often the 
possibility to execute an application after printing. This could be used to create the <PDF-
filename>.log file. It must be possible to set the filename “<PDF-filename>.log” as a parameter. The 
following steps describes the general setup of such a mechanism. 

1. Create a file “createlog.bat” in the PDF output folder which looks like this: 
set FILENAME=%~n1 
set FILEPATH=%~dp0% 
echo Done > %FILEPATH%/%FILENAME%.log 

2. Configure your PDF printer to execute the Windows cmd shell (e.g.: 
C:\WINDOWS\system32\cmd.exe ) with the following parameters (e.g %f is the filename 
parameter) : 
/c C:\officesuite\pdf\createlog.bat %f 

 

Setup the PDF Printer 
1. To setup the PDF printer (Manager > Office Suite > PDF Printer), select the PDF printer from 

the printer list. 

2. As soon as the PDF printer is selected, the following Office Suite configuration parameters are 
added to the Office Suite configuration table ( System > OfficeSuite > Configuration table): 

 GDM_PDF_BATCH 

 GDM_PDF_DIRECTORY 

The value of this configuration parameter has to be the same as the value for TEMP in the 
OfsPdf.properties file. Add "\*.pdf" at the end of it. 

 GDM_PRINTER 

 GDM_PRINTER_DRIVER 

 GDM_PRINT_PORT 

Note  GDM_PRINTER, GDM_PRINT_DRIVER, GDM_PRINT_PORT are set 
automatically. 

3. The value for the Office Suite configuration parameter GDM_ARC_NOD has to be the same as 
the value for varenv.CLI_HST in the OfsPdf.properties file. 

4. In the OfsPdf.properties file the following has to be set as well: 

 host (e.g. plmhost) 

 port (e.g. 20001) 

 env (e.g. plmref) 

5. In the OfsPdf.properties file the correct user has to be entered under "client1". 

6. Link the PDF Generator to a lifecycle: 
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The PDF Generator has to be linked to the respective transition states for the STD-DOC 
lifecycle. The Office Suite provides a LogiView procedure (GdmBatch/Archive) to add a job into 
the PDF job list. This LogiView procedure is a transition procedure for the usage within the 
lifecycle of the Office document. 

The following transition settings can be used: 

Field  With  change management  Without  change 
management  

From 220 120 

State (From) Approved In Approval 

To 230 230 

State (To) Release Released 

System X  

For Change Management X  

Pre-Action xedbusr_tor_rr_vr xedbusr_chk_no_obj_ews & 
xedbusr_tor_rr_vr & sig_cre_sgn 

Post-Action Xedbusr_tor_sa_uv & 
xchg_prd_unt_poa & 
GdmBatch/Archiv 

Xedbusr_tor_sa_uv & 
xedbusr_rst_prd(260) & 
GdmBatch/Archiv 

Thus, when an Office Suite document reaches this state, a PDF is created automatically. 

7. Add "GdmBatch/Archiv" to the respective states in the Lifecycle mask. 

Note  After updating the lifecycle states, the client needs to be restarted. 

8. For every file type, for which a PDF should be created, the ‘Create Archive Format’ checkbox 
has to be selected in the File type mask (System > Office Suite > File Types). 

Note  The PDF generation can only be used for file types of the storage type Single! 
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Configure the Agile PLM Office Suite PDF Service 

The Agile PLM Office Suite PDF Service does require some information about the local 
environment, e.g. the exchange file between the PDF printer and Agile e6.1.1. 

The configuration file of the Agile PLM Office Suite PDF Service has corresponding settings within 
the Agile e6.1.1 Office Suite configuration (System > Office Suite > Configuration). 

The configuration table describes the settings of the configuration file of the Agile PLM Office PDF 
Service and the configuration settings of the PLM Office Suite configuration. 

Office Suite configuration for the PDF service: 

Var iable  Value  Descr ipt ion 

GDM_ARC_NOD Hostname of the PDF Service machine 
(e.g. pdfsrv) 

Host on which the PDF files are created (PDF 
batch client) 

GDM_PDF_BATCH RUN Control parameter of the job ‘PDF 
Generation’ 

GDM_PDF_DIRECTORY PDF exchange directory (e.g. 
C:\officsuite\PDF_generation\*.pdf) 

Working file of the PDF generator (including 
absolute path and generic file name) 

Runtime 
The Agile PLM Office Suite PDF Service can be started via the Windows service manager. The 
service connects to a PLM server and starts the LogiView procedure GdmBatch/Spooler to process 
the PDF job list.  

Note  The service should not be stopped via the Windows Service Manager, because the PLM 
server may not shut down.  

To stop the Agile PLM Office Suite PDF Service, select shutdown in the no-select menu of the PDF 
job list. This operation sets the Office Suite configuration parameter GDM_PDF_BATCH to STOP. 
The LogiView procedure GdmBatch/Spooler checks that parameter and shuts down. During the 
shutdown of the spooler the Office Suite configuration parameter GDM_PDF_BATCH is set to RUN 
again.  

The userexit sets the Office Suite configuration parameter:  

Name Runt ime Set t ing  Shutdown Set t ing  

GDM_PDF_BATH RUN STOP 
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Chapter 10  

Setup Online Help 
There are two types of online documentation available: 

 Online Help for Java Client and Web Client needs to be setup separately.  

Note  This Online Help does not provide a full text search. 

 Online Help for all Agile e6.1.1 features is available in the Native Windows Client. Because of 
restrictions caused by the Microsoft HTML Help format, this help is available only on Windows 
computers running Internet Explorer 6.0 or later. 

Note  The Online Help cannot be opened with Mozilla Firefox. 

Java and Web Client 
To make the Online Help for masks, fields, menus, userexits, etc. available in the Java and Web 
client, complete the following steps: 

1. Change to the following directory: <installation_media>/packages/ 

2. Extract the file clienthelphtml.zip in a temporary directory. This will create the directory structure 
".\axalant\htd\htdocs\axalant\doc_ep\eng". 

3. There you can find the file hlp_e6.zip. Extract the file hlp_e6.zip in that directory.  

Note  At the moment the zip file is only available in English. Copy the file hlp_e6.zip from 
the “eng” directory to the “ger” directory and extract it there if the dump language is 
set to German. 

4. Copy the "axalant" folder under the htdocs to a web server of your choice (e.g. to the http 
server of your Oracle Application Server installation). Copy the axalant folder directly below 
your document root of your web server. 

5. Log in as a manager user (edbcusto, demoep_m). 

6. Select System > Other Parameters. 

7. In the configuration mask, search for Rubric EDB-HLP and select the folder Configuration 
parameter. 

8. Set the documentation root EDB-HLP-ROOT to: http://<http server name>:<http port>/axalant/  

The program adds /doc_ep/eng/ or /doc_ep/ger/, depending on which language is active, 
followed by the index file name index.html. 

 English: http://<http server name>:<admin http port>/axalant/doc_ep/eng/index.html 

 German: http://<http server name>:<admin http port>/axalant/doc_ep/ger/index.html  

On UNIX Systems, Agile e6.1.1 starts Mozilla as a default. If the browser is not defined, follow the 
steps below: 
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1. Select Manager > External Applications to specify different browsers on different operating 
systems and client nodes.  

This is where the default browsers for each available UNIX System are defined. (For Microsoft 
Windows the default system HTML browser is used.) 

2. Copy the line for your hardware architecture and insert the hostname and browser name.  

Note  Make sure that all of the following are true: 

 File type is equal to html 

 Mode is equal to H (help). 

 “-“ is a wildcard and means every possible value (like *). 

Native Windows Client 
The Online Help for the Windows Client is installed together with the client software. No special 
setup is required.  

If you want to use the HTML-based help (Java and Web Client) also in the Windows Client, you 
need to do the following: 

1. Open the Windows client. 

2. On the desktop, right click and select Open > System > Defaults.  

3. Search for the variable EDB-HLP-TYPE, and change its value from MSH to HTTP to activate 
the use of the http protocol.  

As this variable is optional, it might not exist. Create the variable EDB-HLP-TYPE with the type 
String. 

4. Proceed as described under Java and Web Client. 

Unzip the file and set the respective defaults. 
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Chapter 11  

Appendix 

Environment Configuration Parameters 
Each axalant server process has an environment, which is set on startup. An axalant environment 
consists of environment variables which are set thru shell scripts and additional configuration values 
read by the axalant server process at startup from xml configuration files. Information about 
DataView server environment variables can be found in the DTV User's Guide 

Startup process on Windows 
 Invoking axalant server startup thru DataView Daemon or Java Daemon  

 %ep_root%\axalant\cmd\axalant_srv.cmd  
 %ep_root%\axalant\cmd\plm_env.cmd (read for all applications)  
 %ep_root%\axalant\cmd\plm_env_dev.cmd (if exists, read for all applications, not available 

in standard installation)  
 %ep_root%\axalant\cmd\plm_env_cust.cmd (if exists, read for all applications, not 

available in standard installation, customers should add their modifications for all 
applications here)  

 %ep_root%\init\%env_name%.cmd (read for specified application only)  
 %ep_root%\init\%env_name%_cust.cmd (if exists, not available in standard installation, 

read for specified application only, customers should add their modifications for all 
applications here)  

Startup of axalant server process which reads  

 %ep_root%\init\axalant.xml (read for all applications which have defined it in 
"%ep_root%\init\%env_name%.xml", which is the default)  

 %ep_root%\init\%env_name%.xml  

Startup process on Unix 
 Invoking axalant server startup thru DataView Daemon or Java Daemon  

 ${ep_root}\axalant\scripts\axalant_srv  
 ${ep_root}\axalant\scripts\plm_env.sh(read for all applications)  
 ${ep_root}\axalant\scripts\plm_env_dev.sh(if exists, read for all applications, not available 

in standard installation)  
 ${ep_root}\axalant\scripts\plm_env_cust.sh(if exists, read for all applications, not available 

in standard installation, customers should add their modifications for all applications here)  
 ${ep_root}\init\${env_name}.sh(read for specified application only)  
 ${ep_root}\init\${env_name}_cust.sh(if exists, not available in standard installation, read for 
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specified application only, customers should add their modifications for all applications 
here)  

Startup of axalant server process which reads  

 ${ep_root}\init\axalant.xml (read for all applications which have defined it in 
"${ep_root}\init\${env_name}.xml", which is the default)  

 ${ep_root}\init\${env_name}.xml  

Startup Shell Scripts 

This section describes the environment variables which can be modified by the customer. If the 
environment variable should be set for all applications use "plm_env_cust.<extension>", if the 
environment variable is application specific then use "%env_name%_cust.<extension>". If the files 
do not exist they must be created. 

Environment 
Variable 

Description Values Optional Example 

axalant_tmp Path to the PLM server log 
files. 

$ep_root/tmp no $ep_root/tmp or 
%ep_root\tmp 

axalant_data Path to the PLM root $ep_root not used in 
code! 
Maybe 
obsolete 

$ep_root or %ep_root 

ORACLE_HOME Path to the oracle client 
home directory.  

- no D:\oracle\product\11.1\
db_1 

NLS_LANG National Language Set for 
the oracle client to use for 
the axalant server process. 

- no AMERICAN_AMERIC
A.WE8MSWIN1252 

TNS_ADMIN Path to the tnsnames.ora 
for the oracle client to use 
for the axalant server 
process. 

- no %ORACLE_HOME%/
network/admin 

EP_DEBUG A comma separated list 
containing the modules 
that should generate 
debug output. 

Special entries are _all_ to 
debug all modules, Main 
for the main routine and 0 
to turn of debug output. 
If debug output is enabled, 
each e6 process creates 
an axalant-<hostname>-
<pid>.err and .out file to 
capture stderr and stdout. 
Be aware that using the 
value _all_ will have a 
negative performance 

_all_, 0, or a 
comma separated 
list of module IDs 
(as defined in 
axalant.xml or 
ebd_mid.h). 

Yes Main,Mod,Epq,Lgv 
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impact on the e6 server, 
and it will generate huge 
log files.  

EDB_LOGDIR Directory for the log files 
created by the 
EP_DEBUG setting. 
Default is ${ep_root}/tmp. 

Directory with 
path 

Yes /my/log/dir 

EDB_LOGSIZEBUFFER Buffer size in bytes for 
stderr output. If 0 is 
specified, the output will be 
unbuffered. 

A value of 0 should only be 
used if crashes occur and 
the log buffer is not flushed 
to disk. 
Maximum size used is 
currently 1024, values 
greater than 1024 are 
ignored.  

0 to 1024 Yes 1024 

EDB_TRC_ALL Deprecated. Use 
EP_DEBUG with Epq 
instead. 

   

EDB_TRC_DEBUG Deprecated. Use 
EP_DEBUG with Epq 
instead. 

   

PATH PATH to use for the 
axalant server process. 

- no PATH=%ORACLE_H
OME%/bin;%PATH% 

Startup Configuration Files 
In e6.1 the application configuration files are in XML format and can be found in the <ep_root>/init 
directory ( e.g.: <application>.xml and axalant.xml ). They replace the former *.edb files in the same 
directory. Some basic attributes in the application specific <application>.xml file can be modified 
over the admin client web interface. If you need to change the enhanced attributes the files can be 
edited manually with an editor.  
All changes not performed over the admin client web interface will be lost if you use the 
admin client web interface again to change the values of the application.  

<application>.xml  

The following section describes the attributes of the xml nodes that can be defined in the xml file. 
in a standard installations not all attributes are defined in the xml file and default values are used. 

General Node  

<General SignalFlag="1" ModuleConfig="axalant.xml" TraceConfig="" 
UseCommonTraceFile="1"/> 
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Attribute Description Values Optional Example 

SignalFlag If the entry is 1, e6 catches 
runtime errors and stops 
the server process in a 
controlled manner. 

For instance, all database 
connections are 
disconnected. 
This might cause hanging 
server processes and is 
therefore deactivated by 
default.  

 

0 or 1 Yes 1 

ModuleConfig Contains the name of the 
configuration source which 
is used as the primary 
source for the e6 module 
definitions. 

All modules of this source 
are registered.  
From the original 
configuration source, only 
the modules entered in 
[Modules\Custom] will be 
registered.  
The module IDs must be 
unique over all sources.  

 

File name of the primary 
module source:  

[X:][path]filename.xml  
[F:][path]filename.edb  

If specified without type F 
or X, the same type as the 
original source is 
assumed. If specified 
without path, ${ep-
root}/init is used.  

 

Yes axalant.xml 

TraceConfig The Path to the C++ trace 
configuration file. 

F:<path to trace config 
file> 

Yes F:D:\oracle\p
lm61\axalant
\ini\trace.edb 

UseCommonTraceFile If the entry is 1, the PLM 
server writes all common 
traces (SQL, C/C++ and 
LogiView) into the standard 
server trace. 

0 or 1 Yes 1 

Database Node 

<Database Library="epq10c_ora111" Vendor="Oracle" Version="111" 
User="yin@melon" Pwd="yin" 
      DbBlobLocation="edb_lob" 
      ParallelConnect="NO_PARALLEL_CONNECT" 
      ParallelConnectTimeout="10" 
      DbWuqSP="Static" 
      BindMode="All" 
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      Wildcards="?%" 
      Querymode="MIXED"> 
   </Database> 
 

Attribute Description Values Optional Example 

User The schema name and the 
sqlnet connect string of the 
database to which the 
application should connect to. 

e.g. plmref@plm61 n - 

Pwd The password of the 
database schema to which 
the application should 
connect to. 
Can encrypted but also 
cleartext passwords are 
possible. 

e.g.: plmref  
or encrypted e.g: RSA-
PUBLIC-
BASE64:JoMHOs.....N
pMCDcytN+DJI= 

n - 

DbBlobLocati
on 

Tablespace for the database 
Blob fields 

edb_lob   

ParallelConn
ect 

This setting manages the 
ORACLE database 
connection behavior when a 
data record is going to be 
updated with the function 
"epqupdpar()". The major 
use case for this functionality 
is the number server so that 
drawing a new number from a 
number cycle is done in a 
parallel connection. The 
concurrency of the requested 
data modification is vastly 
improved by enabling a 
parallel connection. 
Important: This setting does 
not influence the standard 
behavior of any database 
transaction, it is only 
important for a very small 
number of functions explicitly 
using "epqupdpar()" instead 
of "epqupd()" 

 NO_PARALLE
L_CONNECT - 
Update of the 
data record via 
"epqupdpar()" 
will be 
executed within 
the current 
transaction. 
The 
concurrency of 
an application 
transaction is 
low and this 
setting should 
be used only 
for small 
installation size 
and/or small 
number of 
statements in a 
transaction.  

 PERMANENT_
CONNECT - A 
permanent 
parallel 
database 
connection will 
be opened 
when an 
update of a 
data record via 

Y,  
Default in 
EPQ: 
'NO_PARALL
EL_CONNEC
T' 
Default in 
Installation: 
'ON_DEMAN
D_CONNEC
T' 

- 
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"epqupdpar()" 
is requested. 
This 
connection will 
require 
additional 
memory 
resources in 
favor of a fast 
response time 
for an update. 
The 
concurrency of 
an application 
transaction is 
high.  

 ON_DEMAND
_CONNECT - 
A temporary 
parallel 
database 
connection will 
be opened 
when an 
update of a 
data record via 
"epqupdpar()" 
is requested. 
This 
connection will 
require 
temporarily 
additional 
memory 
resources and 
will also take 
more time for 
execution due 
to the time 
required to 
open and close 
a parallel 
connection. 
Closing the 
parallel 
connection is 
influenced by 
the 
"ParallelConn
ectTimeout". 
The 
concurrency of 
an application 
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transaction is 
high. This 
setting is the 
best one if the 
memory 
resources are 
very limited.  

 

ParallelConn
ectTimeout 

Determines when the parallel 
connection in mode 
"ON_DEMAND_CONNECT" 
will be closed after 
<ParallelConnectTimeout> 
seconds due to inactivity. 
After each read-only 
statement a check occurs 
when an update in the last 
parallel connection has 
happened and if the timeout 
has been exceeded the 
parallel connection is closed. 

Value in seconds e.g. 
10 for 10 seconds 
inactivity 
A value of 0 will close 
immediately the 
parallel connections 
after it has been used. 

Y,  
Default in 
EPQ: 0 
Default in 
Installation: 
10 

- 

DbWuqSP Defines which algorithm will 
be used for a "Where Used 
Query" or "Structure 
Explosion". There is a 
"dynamic" version available 
which created during runtime 
temporarily a stored 
procedure which is suited to 
the requested query for a 
specific table. The other 
version uses a stored 
procedure which is static and 
part of the standard database 
dump. 
This is an internal 
parameter, please change it 
only after advised from a 
support engineer. 

 Static - Static 
stored 
procedure in 
database dump 

 Dynamic - 
Stored 
procedure 
which will be 
created during 
runtime  

 

Y, Default is: 
'Static' 

 

BindMode Manages the usage of place 
holders in the dynamic SQL 
statements. Using place 
holders is important to avoid 
the need to parse SQL 
statements if many SQL 
statements have the same 
structure but different values 
for variables. Not using place 
holders will add the parsing 
time on database server side 
to the execution time for each 

Value is an integer 
handled as a bit 
mask, each value is 
specific for a 
condition value in a 
WHERE-clause. 
The value in a 
clause is the SQL 
keyword:  
 Intervall 

(between): 1  

Y, Default is 
31, for Oracle 
8 Databases 
it has been 
only Equal(2) 

Using place 
holders for all 
conditions:31 
Using place 
holders only for 
an Interval and 
Equal 
conditions:3 

Oracle® Agile Engineering Data Management Chapter 11 - 53

 



Administration Manual for Agile e6.1.1  
 

SQL statement.  
This is an internal 
parameter, please change it 
only after advised from a 
support engineer. 

 Equal (=): 2  

 Like (like): 4  

 Less than or 
greater than: 
(<,>):8  

 Less equal or 
greater egual: 
(<=,>=): 16  

 

Wildcards Sets the characters to 
define the single and the 
multi wildcard in the 
database. A single 
wildcard is a place holder 
in a query for exactly one 
character, a multi 
wildcard is a placeholder 
for zero to many 
characters. 
There are many places in 
the application to define 
wildcards, it is important 
to understand in which 
order the wildcard 
definitions are evaluated. 
Please see here the 
order of evaluation (first 
line is also first 
evaluated):  

 Configuration 
parameter (this entry 
here) Wildcards  

 Command line 
parameter: -w  

 DataView Defaults 
SYSTEM parameter: 
WILDCARD  

 DataView Defaults 
USER parameter: 
WILDCARD  

To simplify the wildcard 
definition it is strongly 
recommended to use the 
WILDCARD parameter in 
the DataView defaults 
only.  

Any combination of 2 
ANSI characters, 
special characters are 
recommended 

Y, Default: 
'?%' 

Setting an 
asterisk for multi 
wildcard like on a 
Windows or UNIX 
shell: '?*' 
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Querymode Defines the mode how a 
query for data will be 
handled. Queries for 
exact matches and 
wildcard matches are 
distinguished. An exact 
match is containing no 
wildcard e.g. 'abcdef' 
while a wildcard match 
contains any combination 
of wildcards e.g. 
'a?cd%f'. 
There are many places in 
the application to define 
the query mode, it is 
important to understand 
in which order the query 
mode definitions are 
evaluated. Please see 
here the order of 
evaluation (first line is 
also first evaluated):  

 Configuration 
parameter (this entry 
here) Querymode  

 Command line 
parameter: -q  

 DataView Defaults 
SYSTEM parameter: 
QUERYMODE  

 DataView Defaults 
USER parameter: 
QUERYMODE  

To simplify the query 
mode definition it is 
strongly recommended to 
use the QUERYMODE 
parameter in the 
DataView defaults only.  

 

 SENSITIVE - 
Queries will 
distinguish 
upper and 
lowercase 
character. This 
will provide the 
best database 
performance.  

 INSENSITIVE - 
Queries will not 
distinguish 
between upper 
and lower case 
characters.  

 MIXED - 
Queries will 
use 
'SENSITIVE' 
for exact 
matches and 
'INSENSITIVE' 
for wildcard 
matches. This 
provides the 
best balance 
between 
performance 
and usability of 
a query  

 

Y, Default in 
EPQ: 
'SENSITIVE' 
Default in 
DTV:'MIXED' 

A query for 'abc' 
match in  

 SENSITIVE
: only 'abc'  

 INSENSITI
VE: 'abc', 
'Abc', 
'ABC', 
'aBc', ...  

 MIXED: for 
exact 
matches 
only 'abc', 
for wildcard 
matches 
'abc', 'Abc', 
'ABC', 
'aBc', ...  

 

 

Security 

<Security KeyStoreFile="file://D:/oracle/plm61/init/ewallet.p12"  
      Wallet="cwallet.sso"  
      KeyAlias="C=DE,ST=Baden,L=Karlsruhe,O=Oracle,OU=Agile PLM,CN=PLM"  
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      TicketKey="RSA-PUBLIC-
BASE64:D8VyVSBxMfgXcZ8AXhOSZMI6Agh4IVQdU49RgszulDGm+z7dQbSIBYRWbpdfsYgP
s4GmjQL//tVYLdttGvLw6n2uN4/iwLFjGO93PtzGuX7TGqWZQkgXR4pGw7M2KjXMDNN/nIL
9rwlWyRKYLOzHZka1ZMgaopEuwPRmsqoQ2lU="> 
   </Security> 
 

Attribute Description Values Optional Example 

KeyStoreFile The location of the 
Oracle Wallet file 
used by the PLM 
server. 

file://%ep_root%/init/ewallet.p12 no file://D:/oracle/plm61/
init/ewallet.p12 

Wallet The name of the 
Oracle Wallet file 
used by the PLM 
Java applications. 

cwallet.sso no Do not change the 
default value! 

KeyAlias The identification of 
the PLM server key. 

C=DE,ST=Baden,L=Karlsruhe,
O=Oracle,OU=Agile 
PLM,CN=PLM 

no Do not change the 
default value! 

TicketKey The encrypted key 
for the ticket module. 

RSA-PUBLIC-BASE64:........ no Do not change the 
default value! 

IPC Node 

<IPC AbsEciUrl="eci://www.example.com:19997" SecurityLevel="process" 
TicketLifeTime="600"          
       Protocol = "1" 
       Node = "www.example.com"> 
   </IPC> 

 

Attribute Description Values Optional Example 

AbsEciUrl The url where the business 
service can be reached on the 
oracle application server. 
The port must match the "Port" 
entry in the ABS_<env>.ini file 
on the oracle application 
server. 

eci://www.example.com:19997 - - 

Protocol (also configurable in the 
command line) 

If the configuration file or 
command line contains both 
entries and 
if the command line also 
contains the resource to be 
used, 
e6 is started in ECI Server 
mode and can be contacted by  
ECI clients via the specified 

<ECI Protocol ID> Yes 1 
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parameters (see ECI Manual).  

 

Node The host name of the e6 
server when running as an ECI 
server. 

Fully qualified host name Yes example1.or
acle.com 

SecurityLe
vel 

This entry specifies the 
security level to be used for 
IPC connections. 

The default value of 
connection should be used 
whenever possible, to ensure 
that no unauthorized access is 
possible. 
Use the other values only if a 
legacy integration is not 
capable of passing credentials 
during an ECI connect. 
An e6 environment using a 
value other than connection 
should be secured by firewalls, 
so that only the legacy system 
has remote access to the e6 
server.  

 

One of:  

unrestricted: no authorization 
required to establish the 
connection.  

process: first IPC connection 
needs to authorize by passing 
credentials.  

connection: each IPC connection 
needs to authorize by passing 
credentials. [default]  
 

Yes process 

TicketLife
Time 

The life time value of PLM 
tickets for multiple ECI 
connections. 

expire value in seconds Yes 600 

Modules Node 

<Modules> 
       <Core> 
           <Class Name="Classification" Library="epsrv_edb" 
Type="embedded" Startup="immediately"/> 
       </Core> 
       <Custom> 
           <Sample Name="Sample Custom module" Library="sample"/> 
       </Custom> 
   </Modules> 

The Modules element contains two child elements called Core and Custom. Each of these child 
elements may contain any number of module definitions, where the element name is used as 
Module ID.  

 

 

 

The attributes of each element are as follows:  
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Attribute Description Values Optional Example 

Name A short description of the module. 
This is displayed in the library list of 
e6. 

A human readable name No Sample 
Module 

Library The name of the library to be 
loaded, if possible without path and 
operating-system-specific suffix 

Library name No epsrv_sample 

Entry The name of the entry function of 
the module. 

This information is provided by the 
supplier of the respective module. 
If the entry does not exist, it is 
derived from the module ID as 
follows: 
<mod-id>_Entry  

Function name Yes Sample_Entry 

Startup Controls the automatic start-up of a 
module. 

If the entry does not exist, the 
module is only loaded, initialized 
and started on demand.  

 

One of  
 immediately: Start the 

module immediately 
during server startup.  

 onDemand: Start if a 
userexit requests the 
module [default]  

 disabled: Do not start 
the module.  

 

Yes onDemand 

Type Specifies the module type, 
standard is dynamic. 

One of: 

Static  
 embedded: Only used 

for internal e6 
modules.  

 dynamic: Standard 
value for external 
modules. [default]  

 

Yes dynamic 

 

LogFileMgr/CpsVerify Node 

<LogFileMgr> 
       <CpsVerify Mode="append" Prefix="CpsVerify"> 
       </CpsVerify> 
   </LogFileMgr> 
 

Attribute Description Values Optional Example 
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Mode Logfile mode. For CpsVerify the value 
is overwritten by user specific DTV 
default "CPS_LOG_FIL_MOD". So 
adapt the DTV default instead of 
changing value here. 

 trunc = truncate log 
message file before 
writing log messages  

 append = append 
log messages to file  

 

yes Mode="append" 

Prefix Prefix for logfile. Not evaluated yet for 
CpsVerify, prefix is always set to 
value "CpsVerify". 

CpsVerify yes Prefix="CpsVerify" 

PLMPresentationServices Node 

<PLMPresentationServices 
Report_Service_URL="http://www.example.com/reporter/report"/> 
 

Attribute Description Values Optional Example 

Report_Ser
vice_URL 

Lightweight reporting URL, 
generated automatically. URL on the 
configured oracle application server. 

http://www.examp
le.com:7777/repor
ter/report 

  

Environment Node 

Environment>         
       <Windows DATAVIEW_TBSP="edb" DATAVIEW_IXSP="edb_idx" ... 
DATAVIEW_DUMP="<EP_ROOT>\axalant\dmp" ...> 
           <intel-ms-nt5.0/> 
       </Windows> 
       <Unix ... > 
           <ia32-linux-sles10/> 
           <rs6000-ibm-aix5.3/> 
           <sparc-sun-solaris10/> 
           <hppa-hp-hpux11.23/> 
           <ia64-hp-hpux11.31/> 
       </Unix> 
   </Environment> 
 

Environment variables for the axalant server process can be set here, or in the startup scripts 
defined above. 

These values will overwrite all previously defined values from e.g. startup scripts. 
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